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System Description 
 
The Bird Dog 3-11 System consists of a Bird Dog 3-11 Unit and one or more options.   
 
 
The options available are: 

 
Vibrator QC Option - Includes cables for connecting a unit to a Force III, Force II, 
or Sercel Vibrator control electronics unit.  When taking similarities with this 
option, the accelerometer signals used for calculating Ground Force come from 
the accelerometers connected to the control electronics unit.  If the Force III or 
Force II interface cables are used, several other signals, such as TM Current, 
Valve Feedback, etc., can be acquired for analysis.  Cables are included in this 
option for doing zero time tests. 
 
Independent Accelerometer Option - Includes hardware for using independent 
accelerometers for taking similarities from one vibrator at a time. 
 
Wireline Option - Includes cables for taking wireline similarity signals from an 
encoder and up to 5 vibrators simultaneously. 
 



  Unit Description 

The Bird Dog 3 - 11 VibQC Unit consists of a hardware unit, software, a power cable, 
and an Ethernet cable.   
 
The hardware unit, shown on the Unit Description Drawing pages, has: 

• Hardware for digitizing analog signals,  
• Trigger inputs for measuring timing differences between Time Breaks from two 

units. 
• Data storage,  
• GPS data interface for storing the position, time, and date of each acquisition in 

the data files, 
• Ethernet interface for connecting a computer for unit setup, signal analysis, and 

data storage.  The Ethernet interface is 100 base T with an TCP/IPv4 address in 
the 10.0.X.X range where the X.X will be assigned to the unit at when it is 
manufactured.  The Subnet Mask will be 255.0.0.0 

 
The hardware unit is ruggedized and designed to be easily usable by all levels of crew 
personnel. 
 
Unit specifications: 
Unit Weight: 7.6 lb (3.45 kg) 
Unit Dimensions: Handle Down - 6.75" X 4" X 11.1875"  (17.15 X 10.6 X 28.4 cm) 

         Handle up - 6.125" X 6.75" X 11.1875"  (15.6 X 17.15 X 28.4 cm) 
System dimensions and weight will depend on the packaging selected. 

 

Power Required 9.5 to 26.5 VDC, 6 Watts (430 ma with 14 Volts input power) when not 
supplying power to accelerometers. 
Maximum Analog Signal Input Levels: + 15V. 
Time Break Input Maximum Voltage: + 15V. 
Signal input options: 

• Time break from Encoder/Decoder - NISO inputs to check start time 
• Wireline signals from Connector Panel, WL REF and SV OUT 
• REF Input (BNC #1) can be TRUE REF or WL REF, depending on the kind of 

testing being done 
• BNC Inputs 1 through 8 - can be magnetically mounted accelerometers that 

require power from the unit or other analog signals.   
• BNC Inputs 9, 10, and 11 can be analog signals.  
• 55 Pin Service Connector - connects to service cables that may be connected to 

various vibrator control units to record such signals as reference, accelerometer 
signals, actuator control and instrumentation signals, etc. 

• GPS - Receives RS232 $GPGGA messages at 19.2KBaud and PPS pulses and 
stores GPS time and date with data files if GPS signal is present when the data 
is acquired.  The BD3-11 VibQC records whether a valid GPS message was 
being received or not. 

 
 



Bird Dog 3-11 
 7 

Software - SourceSignature or VibraScope from Seismic Source Company can be used to 

interface a computer with the unit.  The two applications function similarly, however Source 

Signature has features that VibraScope does not have.  These additional features make 

SourceSignature better suited for use with the Bird Dog 3-11 VibQC and Force 3 units.



   

Front Panel 

 

 
 

POWER LED 

 
On when the unit has power supplied. 

 

STATUS LED 

 
On dimly for a few seconds while powering up then on brightly when the unit is acquiring data. 

 

BATTERY LED 

 
On dimly for a few seconds while powering up then flashes brightly when the unit is operating. 

 

CURRENT REGULATOR LED 

 
On when the power for magnetic accelerometers or M6 (Vibrator Control System) accelerometer 

test is on.  Attention!  The power supply may be on when the Bird Dog unit is powered up if it 

was last used for testing requiring that power, e.g. Magnetic Accelerometer or Accelerometer 
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Test modes.  Make sure this LED is off before  connecting the unit to vibrator 

control units for Vibrator QC, Wireline, or Zero Time tests.  If the LED is on, the 

supply may be turned off by entering the DAQ Setup mode, then selecting one of these modes, 

and then by left clicking on the OK button at the bottom of the DAQ Configuration window. 

 

ETHERNET Connector 

 
Ethernet to a computer, switch, etc. should be connected here 

 

POWER Connector 

 
9.5 to 26.5 VDC approximately 0.5 Amps should be supplied 

 

TIME BREAK Input 

 
A Time Break signal may be connected here to start acquisition. 

 

AUX Input 

 
Not currently used. 

 

REFERENCE Input 

 
Reference from an encoder is usually input here.  The signal may be True Reference or Wireline 

Reference, depending on the operation in progress.  Reference from another device, such as a 

vibrator controller may be used. 

 

DISCRETE SIGNALS Inputs 



 
Signals from discrete sources may be input to these BNC connectors. 

 

55 PIN Connector 

 
Seismic Source service cables, typically for connecting to vibrator control units, connect 
to this. 
 

WIRELINE SIMILARITY Vib Inputs 

 
Connect to the WIRELINE connectors on vibrator connector panels. 
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  Operational Modes 

 

Vibrator QC Mode 
The Bird Dog 3-11 unit supports doing quality control testing of seismic vibrators both 
with the accelerometers that are installed on the actuator as part of the control 
electronics unit, and also with independent accelerometers.  The independent 
accelerometers provided with the Independent Accelerometer Option are often attached 
to the actuator with magnetic bases supplied as part of the option. 
 
The unit supports Zero Time testing to ensure or aid in setting start timing of an encoder 
with decoders. 
 

Wireline Mode 
The unit supports the acquisition of Wireline Similarities, by simultaneously recording 
two signals each from up to five vibrators, typically wireline reference and vibrator 
output, and wireline reference from an encoder. 
 

Independent Accelerometer Mode 
The unit has BNC connectors that support the input of Time Break, Reference, and up to 
10 additional signals.  The signal inputs are differential.  Channels 1 through 8 can also 
provide power for independent accelerometers.  Channel 1 is typically used as a 
reference signal input, but it can be used for an independent accelerometer in the 
Advanced mode.  Reference may be connected to channels 9, 10, or 11 and those 
channels may be assigned to the reference function for analysis functions.  
 

Accelerometer Test Mode 
The Bird Dog 3-11 will also test Seismic Source M5/M6 accelerometers. 
 

Force III Mode 
A computer running the Source Signature program can be connected directly to the 
Ethernet port of a Force III vibrator control unit without using a Bird Dog 3-11 for VibQC 
testing. 
 

Downloading Stored Data 
The Source Signature program can also download data previously acquired and stored 
in a Bird Dog 3-11 or Force III unit. 



  Vibrator QC Option 

 
Includes cables for connecting a unit to a Force III, Force II, or Sercel Vibrator control 
electronics unit.  Wiring diagrams for the various cables are included in the External 
Cables section of this manual. 
 
When connecting a Bird Dog 3-11 to a Force II or Force III vibrator control unit, the 
service cable for that control unit connects all the signals needed for QC data 
acquisition.   
 
When taking similarities with this option, the accelerometer signals used for calculating 
Ground Force are the same signals the control electronics unit uses to control the 
actuator.  The accelerometer sensitivity for all systems other than Sercel is 25mV/g.   
 
If the Force III or Force II interface cables are used, several other signals, such as TM 
Current, Valve Feedback, etc., can be acquired for analysis.  The Force III cable can be 
used to connect the Bird Dog to a Vib Pro.  When using a Force III cable to connect to a 
Vib Pro, the Drive signal will not be connected.  All other signals will be connected. 
 
Either the VibraScope or Source Signature program may be used for collecting and 
analyzing data. 
 
When connecting a Bird Dog 3-11 to a Sercel vibrator control unit, use BNC cables to 
connect the signals to the Bird Dog 3-11 as shown in the following list: 
 
Signal                            Conection on DSDConnection on Bird Dog 3-11 Unit   
Time Break............................................TB BNC.......................................................TB 1 
TRIGGER                                      
True Reference....................................REF BNC.......................................................BNC 
1 REF 
Ground Force..................................... Force 
BNC..........................................................BNC 2 
 
Optional force signals may be acquired by connecting to the Similarity connector on 
Sercel control electronics.  The cable is not supplied for connecting to that connector.  
MASS ACC and PLATE ACC signals are available on that connector on pins: 
E.... MASS ACC+ 
F.... MASS ACC- 
H.... PLATE ACC+ 
J.... PLATE ACC- 
 
If connecting to these signals, use the VibraScope program and select Sercel Control 
Electronics in the Vibrator Configuration menu. 
If connecting to these signals, connect the PLATE ACC signals to BNC2, + to center and 
- to ring; the MASS ACC signals to BNC3, + to center and - to ring. 
 
Data that is acquired will be stored in the unit and may be downloaded later.  
 
Cables are also included in this option for doing zero time tests. 
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  Independent Accelerometer Option 

 

Includes cables for connecting a unit to independent accelerometers that may be 
mounted on the actuator magnetically or physically attached used provided studs, or 
screws or clamps or other ways. 
 
Cables are provided to connect the unit to a decoder or encoder for reference and time 
break signals. 
 
Source Signature program must be used for collecting and analyzing data.  Source 
Signature turns the power for the independent accelerometers on. 
 
Data that is acquired will be stored in the unit and may be downloaded later.  
 
The sensitivity of the provided accelerometers is 10mv/g. 
 
 



  Wireline Option 

Includes cables for connecting a unit to as many as five vibrators for simultaneously 
acquiring wireline similarities. 
 
Cables are provided to connect the unit to a decoder or encoder for reference and time 
break signals.  Using wireline reference from the encoder is recommended. 
 
Either the VibraScope or Source Signature program may be used for collecting and 
analyzing data. 
 
Data that is acquired will be stored in the unit and may be downloaded later.  
 



Bird Dog 3-11 
 15 

  Accelerometer Test Option 

 
The Accelerometer Test Option provides a way to test M5 or M6 accelerometers used 
with vibrator control electronics units.   
 
The Accelerometer Test Option includes: 

• One M5/M6 Accelerometer Test Cable for connecting the Bird Dog 3-11 to the 
accelerometer to be tested. 

• Accelerometer Test program for computer running Windows operating system.   
 
The test is a static test and does not requre the use of a vibrator, shaker table, etc.  The 
loop and sim acceleroemters under test are checked for: 

• Proper DC Voltage on the accelerometer signal line 
• Noise 
• Sensitivity at + 1g 

 
Inside each M5 or M6 accelerometer unit is one Loop accelerometer and one Similarity 
accelerometer.  The two accelerometers should have identical performance.  The 
accelerometer test option measures and displays the signals from the Loop and 
Similarity accelerometers in the accelerometer unit under test.  



  Quick Start 

Wireline Similarities- 

 
Make sure the Bird Dog unit is powered up and the CURR REG LED is off before 

connecting any cables to the encoder or vibrator control unit. 

 

The following can be done an any order: 

 
• Connect the Ethernet cable from the BD3 (Bird Dog 3-11 VibQC) unit to the 

computer. 

 

• Connect Wireline Reference from the Encoder or a vib to the 1- REF input on the 

BD3. 

 

• Connect Time Break from the Encoder to the TB1 input on the BD3.  Note: See 

the DAQ Setup/Configuration/Acquisition section. 

 

• Connect the BD3 to DC power and ensure the POWER LED is on and the 

BATTERY LED starts flashing a few seconds after power-up. 

 

• Connect the wireline cables from the vibs to the BD3.   

 

The following must be done in this order: 

 
1.Start the Source Signature program. 

 

2.In the Options/Preferences/General menu, Advanced Mode not selected. 

 

3.Open the DAQ Setup menu.  See the DAQ Setup section. 

 

4.Enable and select the Bird Dog that is connected to the computer.  If it does not appear, 

see the Ethernet Setup section.  (IP Address 10.0.0.101; Subnet mask 255.0.0.0; firewalls 

off; TCP/IP Verification off) 

 

5.Select Wireline Mode 

 

6.Enable the channels to be used. 

 

7.Set the Sample Rate, Acquisition Time and trigger mode 

 

8.Vibrator settings are not used. 
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9.OK & Close  

 

10.Press the A key on the computer keyboard or click on a START button on Source 

Signature. 

 

11.Start a sweep. 

 

12.Check for signals on all channels in a Signal Traces plot in the Seismic, Vertical mode 

to ensure signals are received. 

 

13.Analyze signals using desired plots. 

 

14.Save the data 

 

Repeat the procedure, starting with setp 10, “Press the A key…”, to acquire additional 

data if desired. 

 

 

Detailed Quick Start Wireline Similarities 

 
Warning!  Powering up the Bird Dog unit while it is connected to a wireline 

similarity acquisition system may apply DC voltages to the signal inputs.  

Make sure the Bird Dog unit is powered up and the CURR REG LED is off 

before connecting any cables to the encoder or vibrator control unit, 

including the wireline connector or the True Reference BNC on the 

connector panel.  If it is on, see the Source Signature Program/Source 

Signature Program Operation/Options Menu/Wireline Mode or the Mag Acc 

Advanced  Mode section of this menu for instructions about how to turn that 

power supply off.  

 
The following can be done an any order: 

• Connect the Ethernet cable from the BD3 (Bird Dog 3-11 VibQC) unit to the 

computer. 

• Connect Wireline Reference from the Encoder or a vib to the 1- REF input on 

the BD3. 

• Connect Time Break from the Encoder to the TB1 input on the BD3.  Note: This 

is optional.  Acquisition may be started on Time Break, when the Reference 

signal becomes active, or when the user starts acquisition with the A key on the 

keyboard or clicks on the START button on the Source Signature program. 

• Connect the BD3 to DC power and ensure the POWER LED is on and the 

BATTERY LED starts flashing a few seconds after power-up. 



• Connect the wireline cables from the vibs to the BD3. 

 

 

The following must be done in this order: 
1.Start the Source Signature program. 

2.In the Options/Preferences/General menu, make sure the Advanced Mode is not 

selected. 

3.In the Options/Preferences/ other menus, set them as you prefer. 

4.Click on the OK button at the bottom of the Preferences window. 

5.Press the D key on the computer keyboard.  Notes:  1.  This is the same as clicking on 

the Device button in the Options menu or clicking on the Device button at the right end 

of the tool bar.  2.  This should open the DAQ Setup window. 

6.If the BD3 you are connected to appears in the DAQ Setup window make sure the box 

to the left of the BD3 serial number is checked and the line containing the serial number 

and IP address is highlighted (yellow background, black text). 

7.If the BD3 does not appear, click on the Auto Detect button.  

8.If it does not appear, check on the TCP/IPv4 Properties.  Set the IP address for the 

computer to something like 10.0.0.101 and subnet mask to 255.0.0.0 then try the Auto 

Detect again. 

9.Click on DAQ Settings.  The progress bar should stop after going about ½ way across 

the window and the Configuration window should appear. 

10.Left Click on the Wireline option. 

11.Enable the channels you plan to use in the Channels window 

12.Set the Sample Rate and Acquisition Time as you desire.  Set the Trigger to Trigger 

on Time Break if you have a time break cable connected.  Set it to Auto Trigger if you 

want it to start acquisition as soon as you press the A key on the computer or click on the 

START button on the program.  Set it to Trigger On Reference if triggering on time 

break does not work. When you start a sweep. 

13.The settings in the Vibrator tab are not used and do not matter for wireline similarities. 

14.Click on the OK button at the bottom of the Configuration window and the 

Configuration window should close. 

15.Click on the Close button at the bottom of the DAQ Setup window. 

16.In the Options/Auto Download menu, select VSS DAT Files. 

17.Near the bottom of the Source Signature program window, click on the STATUS tab. 

18.Press the A key on the computer keyboard or click on a START button on Source 

Signature. 

19.“START received” should appear in the Status window. 

20.Then “waiting for trigger” should appear in the Status window.   

21.“Waiting…” should appear to the right of the Tx light. 

22.Start a sweep. 

23.“triggered” should appear in the Status window, at the bottom of the Source 

Signature window. 

24.“Recording: NNs” should appear to the right of the Tx light.  NN is a counter 

counting up the seconds of acquisition. 

25.The STATUS LED on the unit should come on and stay on until the sweep ends. 

26.There should be some activity on the Rx and Tx lights, at the bottom of the Source 
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Signature window.  The Rx light should come on for a longer time after the sweep is 

finished, while the BD3 downloads data to the computer. 

27.“Receiving…” should appear to the right of the Tx light while data is downloaded 

from the BD3. 

28.Looking at all channels in a Signal Traces plot in the Seismic, Vertical mode would 

be a good starting place, to see that all the expected channels have signal on them. 

29.After a good similarity is received, do Ctrl+S to start the file save function. 

30.Enter desired text in the Save window then press the Yes button. 

31.Enter a path and file name in the Save As window. 

32.Select the file type in the Save as type window using the pull-down button to the right 

end of that window. 

33.Click on the Save button. 

Repeat the procedure, starting with setp 18, “Press the A key…”, to acquire additional 

data if desired. 
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  Vibrator Quality Control Test 

 
Make sure Bird Dog unit is powered up and the CURR REG LED is off before 

connecting any cables to the encoder or vibrator control unit.  

The following can be done an any order: 

 
• Connect the Ethernet cable from the BD3 (Bird Dog 3-11 VibQC) unit to the 

computer. 

 

• Connect the BD3 to DC power and ensure the POWER LED is on and the 

BATTERY LED starts flashing a few seconds after power-up. 

 

• Connect a cable from the 55 Pin connector on the Bird Dog unit to a test 

connector on a vibrator control electronics unit.   

 

Notes:  1.  The Force III cable may be used to connect to a Vib Pro controller.  In this 

case, the Drive signal will not be connected. 

2.  If connecting the Bird Dog unit to a Sercel vibrator control electronics unit, 

refer to the Operational Modes/Vibrator QC Option section for cabling. 

 

The following must be done in this order: 
1.Start the Source Signature program. 

 

2.In the Options/Preferences/General menu, make sure the Advanced Mode is not 

selected. 

 

3.Open the DAQ Setup menu.  See the DAQ Setup section. 

 

4.Enable and select the Bird Dog that is connected to the computer.  If it does not appear, 

see the Ethernet Setup section.  (IP Address 10.0.0.101; Subnet mask 255.0.0.0; firewalls 

off; TCP/IP Verification off) 

 

5.Select the Vibrator QC Mode. 

 

6.Enable the channels to be used. 

 

7.Set the Sample Interval, Acquisition Time, trigger mode, and Display Units. 

 

8.Ensure the settings in the Vibrator tab are correct. 

 

9.OK and Close. 

 

10.Press the A key on the computer keyboard or click on a START button on Source 

Signature. 



 

11.Start a sweep. 

 

12.Check for signals on all channels in a Signal Traces plot in the Seismic, Vertical mode 

to ensure signals are received. 

 

13.Analyze the vibrator’s performance using the desired plots. 

 

14.Save the data. 

 

Repeat the procedure, starting with setp 10 “Press the A key…”, to acquire additional 

data if desired. 

 

 

Detailed Vibrator Quality Control Test 

 

Warning! Powering up the Bird Dog unit while it is connected to vibrator 

control unit may apply DC voltages to the control unit or the actuator.  This 

may result in the reaction mass pulsing.  Make sure Bird Dog unit is 

powered up and the CURR REG LED is off before connecting any cables to 

the encoder or vibrator control unit, including the wireline connector or the 

True Reference BNC on the connector panel.  If it is on, see the Source 

Signature Program/Source Signature Program Operation/Options 

Menu/Wireline Mode or the Mag Acc Advanced  Mode section of this menu 

for instructions about how to turn that power supply off.  

 

The following can be done an any order: 
• Connect the Ethernet cable from the BD3 (Bird Dog 3-11 VibQC) unit to the 

computer. 

• Connect True Reference from the Encoder or a vib to the 1- REF input on the 

BD3. 

• Connect Time Break from the Encoder to the TB1 input on the BD3.  Note: This 

is optional.  Acquisition may be started on Time Break, when the Reference 

signal becomes active, or when the user starts acquisition with the A key on the 

keyboard or clicks on the START button on the Source Signature program. 

• Connect the BD3 to DC power and ensure the POWER LED is on and the 

BATTERY LED starts flashing a few seconds after power-up. 

• Connect a cable from the 55 Pin connector on the Bird Dog unit to a test 

connector on a vibrator control electronics unit.  Wiring diagrams for cables to 

connect to some commonly used control electronics are in the Externals Cables 

section of this manual.  When using the service cable with Force II or Force III 
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vibrator control units, it is not necessary to connect True Reference and Time 

Break signals, listed above. 

 

The following must be done in this order: 
1.Start the Source Signature program. 

2.In the Options/Preferences/General menu, make sure the Advanced Mode is not 

selected. 

3.In the Options/Preferences/ other menus, set them as you prefer. 

4.Click on the OK button at the bottom of the Preferences window. 

5.Press the D key on the computer keyboard.  Notes:  1.  This is the same as clicking on 

the Device button in the Options menu or clicking on the Device button at the right end 

of the tool bar.  2.  This should open the DAQ Setup window. 

6.If the BD3 you are connected to appears in the DAQ Setup window make sure the box 

to the left of the BD3 serial number is checked and the line containing the serial number 

and IP address is highlighted (yellow background, black text). 

7.If the BD3 does not appear, click on the Auto Detect button.  

8.If it does not appear, check on the TCP/IPv4 Properties.  Set the IP address for the 

computer to something like 10.0.0.101 and subnet mask to 255.0.0.0 then try the Auto 

Detect again. 

9.Click on DAQ Settings.  The progress bar should stop after going about ½ way across 

the window and the Configuration window should appear. 

10.Left Click on the Vibrator QC Mode. 

11.Enable the channels you plan to use in the Channels window.  Enabling all channels 

is recommended. 

12.Set the Sample Interval, Acquisition Time, and Display Units as you desire.  Set the 

Trigger to Trigger on Time Break if you have a time break cable connected.  Set it to 

Auto Trigger if you want it to start acquisition as soon as you press the A key on the 

computer or click on the START button on the program.  Set it to Trigger On Reference 

if triggering on time break does not work. When you start a sweep. 

13.The settings in the Vibrator tab are critical.  If they are not set to correct values, the 

force plots will not be calculated properly. 

14.If a GPS receiver is connected to the Bird Dog unit, click on the GPS tab then on the 

Get Position button to make sure the GPS receiver is sending time and position data to 

the unit. 

15.Click on the OK button at the bottom of the Configuration window and the 

Configuration window should close. 

16.Click on the Close button at the bottom of the DAQ Setup window. 

17.In the Options/Auto Download menu, select VSS DAT Files. 

18.Near the bottom of the Source Signature program window, click on the STATUS tab. 

19.Press the A key on the computer keyboard or click on a START button on Source 

Signature. 

20.“Waiting for trigger” should appear in the Status window.   

21.“Waiting…” should appear to the right of the Tx light. 

22.Start a sweep. 

23.“triggered” should appear in the Status window, at the bottom of the Source 

Signature window. 



24.“Recording: NNs” should appear to the right of the Tx light.  NN is a counter 

counting up the seconds of acquisition.a 

25.The STATUS LED on the unit should come on and stay on until the sweep ends. 

26.There should be some activity on the Rx and Tx lights, at the bottom of the Source 

Signature window.  The Rx light should come on for a longer time after the sweep is 

finished, while the BD3 downloads data to the computer. 

27.“Receiving…” should appear to the right of the Tx light while data is downloaded 

from the BD3. 

28.Looking at all channels in a Signal Traces plot in the Seismic, Vertical mode would 

be a good starting place, to see that all the expected channels have signal on them. 

29.Open plot windows and plot data as desired to analyze the vibrator’s performance. 

30.After a good similarity is received, do Ctrl+S to start the file save function. 

31.Enter desired text in the Save window then press the Yes button. 

32.Enter a path and file name in the Save As window. 

33.Select the file type in the Save as type window using the pull-down button to the right 

end of that window. 

34.Click on the Save button. 

Repeat the procedure, starting with setp 19, “Press the A key…”, to acquire additional 

data if desired. 
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Zero Time Test 

Make sure the Bird Dog unit is powered up and the CURR REG LED is off before 

connecting any cables to the encoder or vibrator control unit. 

 

The following can be done an any order: 

 
• Connect the Ethernet cable from the BD3 (Bird Dog 3-11 VibQC) unit to the 

computer. 

 

• Connect True Reference from the Encoder to the 1-REF input BNC on the BD3. 

 

• Connect True Reference from the Decoder to the 2 input BNC on the BD3. 

 

• Connect Time Break from the Encoder to the TB1 input on the BD3.   

 

• Connect the BD3 to DC power and ensure the POWER LED is on and the 

BATTERY LED starts flashing a few seconds after power-up. 

 

The following must be done in this order: 

 
1.Start the Source Signature program. 

 

2.In the Options/Preferences/General menu, Advanced Mode not selected. 

 

3.Open the DAQ Setup menu.  See the DAQ Setup section. 

 

4.Enable and select the Bird Dog that is connected to the computer.  If it does not appear, 

see the Ethernet Setup section.  (IP Address 10.0.0.101; Subnet mask 255.0.0.0; firewalls 

off; TCP/IP Verification off) 

 

5.Select Zero Time Mode 

 

6.Enable the channels to be used. 

 

7.Set the Sample Rate, Acquisition Time and trigger mode. 

 

8.Vibrator settings are not used. 

 

9.OK & Close  

 

10.Press the A key on the computer keyboard or click on a START button on Source 

Signature. 
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11.Start a sweep. 

 

12.Check for signals on all channels in a Signal Traces to ensure signals are received. 

 

13.Analyze signals using desired plots. 

 

14.Adjust parameter settings for the encoder and/or decoder(s), repeating acquisitions and 

sweeps as necessary, for minimum phase error on the phase plot.   

 

15.Repeat the test for all decoders, starting with setp 10, “Press the A key…”. 

 

16.Save the data (optional). 

 

 

 

 

  Detailed Zero Time Test 

 

Warning! Powering up the Bird Dog unit while it is connected to zero time 

test cabling may apply DC voltages to the signal inputs.  Make sure the Bird 

Dog unit is powered up and the CURR REG LED is off before connecting 

any cables to the encoder or vibrator control unit, including the wireline 

connector or the True Reference BNC on the connector panel.  If it is on, see 

the Source Signature Program/Source Signature Program Operation/Options 

Menu/Wireline Mode or the Mag Acc Advanced  Mode section of this menu 

for instructions about how to turn that power supply off.  

 

The following can be done an any order: 
• Connect the Ethernet cable from the BD3 (Bird Dog 3-11 VibQC) unit to the 

computer. 

• Connect True Reference from the Encoder to the 1-REF input BNC on the BD3. 

• Connect True Reference from the Decoder to the 2 input BNC on the BD3. 

• Connect Time Break from the Encoder to the TB1 input on the BD3.  Note: This 

is optional.  Acquisition may be started on Time Break, when the Reference 

signal becomes active, or when the user starts acquisition with the A key on the 

keyboard or clicks on the START button on the Source Signature program. 

• Connect the BD3 to DC power and ensure the POWER LED is on and the 

BATTERY LED starts flashing a few seconds after power-up. 

 

 

The following must be done in this order: 
1.Start the Source Signature program. 



2.In the Options/Preferences/General menu, make sure the Advanced Mode is not 

selected. 

3.In the Options/Preferences/ other menus, set them as you prefer. 

4.Click on the OK button at the bottom of the Preferences window. 

5.Press the D key on the computer keyboard.  Notes:  1.  This is the same as clicking on 

the Device button in the Options menu or clicking on the Device button at the right end 

of the tool bar.  2.  This should open the DAQ Setup window. 

6.If the BD3 you are connected to appears in the DAQ Setup window make sure the box 

to the left of the BD3 serial number is checked and the line containing the serial number 

and IP address is highlighted (yellow background, black text). 

7.If the BD3 does not appear, click on the Auto Detect button.  

8.If it does not appear, check on the TCP/IPv4 Properties.  Set the IP address for the 

computer to something like 10.0.0.101 and subnet mask to 255.0.0.0 then try the Auto 

Detect again. 

9.Click on DAQ Settings.  The progress bar should stop after going about ½ way across 

the window and the Configuration window should appear. 

10.Left Click on the Zero Time Mode. 

11.Ensure the Encoder Reference and Decoder Reference channels are enabled in the 

Channels window.  

12.Set the Sample Interval, Acquisition Time, and Display Units as you desire.  Set the 

Trigger to Trigger on Time Break if you have a time break cable connected.  Set it to 

Auto Trigger if you want it to start acquisition as soon as you press the A key on the 

computer or click on the START button on the program.  Set it to Trigger On Reference 

if triggering on time break does not work. When you start a sweep. 

13.The settings in the Vibrator tab are not used in this test and are not critical. 

14.If a GPS receiver is connected to the Bird Dog unit, click on the GPS tab then on the 

Get Position button to make sure the GPS receiver is sending time and position data to 

the unit. 

15.Click on the OK button at the bottom of the Configuration window and the 

Configuration window should close. 

16.Click on the Close button at the bottom of the DAQ Setup window. 

17.In the Options/Auto Download menu, select VSS DAT Files. 

18.Near the bottom of the Source Signature program window, click on the STATUS tab. 

19.Press the A key on the computer keyboard or click on a START button on Source 

Signature. 

20.“Waiting for trigger” should appear in the Status window.   

21.“Waiting…” should appear to the right of the Tx light. 

22.Start a sweep. 

23.“triggered” should appear in the Status window, at the bottom of the Source 

Signature window. 

24.“Recording: NNs” should appear to the right of the Tx light.  NN is a counter 

counting up the seconds of acquisition.a 

25.The STATUS LED on the unit should come on and stay on until the sweep ends. 

26.There should be some activity on the Rx and Tx lights, at the bottom of the Source 

Signature window.  The Rx light should come on for a longer time after the sweep is 

finished, while the BD3 downloads data to the computer. 
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27.“Receiving…” should appear to the right of the Tx light while data is downloaded 

from the BD3. 

28.Looking at all channels in a Signal Traces plot in the Seismic, Vertical mode would 

be a good starting place, to see that all the expected channels have signal on them. 

29.Open a Vib Analysis/Phase plot windows and enable the DecRef Channel and 

Assigned Ref or Assigned Ref is selected for the Reference Channel.   

30.Adjust parameter settings for the encoder and/or decoder(s), repeating acquisitions and 

sweeps as necessary, for minimum phase error on the phase plot.   

31.Repeat the test for all decoders. 

32.     If it is desired to save the data, left click on the File/Save menu item or press the 

Ctrl+S keys. 

33.     Enter a Comment in the Save window, then click on the Yes button.  

34.Enter a path and file name in the Save As window. 

35.Select the file type in the Save as type window using the pull-down button to the right 

end of that window. 

36.Click on the Save button. 

Repeat the procedure, starting with setp 19, “Press the A key…”, to acquire additional 

data if desired. 
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Independent Accelerometer Mode 

 
• Connect Bird Dog to computer with patch cable provided  

 

• Connect 9.5 to 26.5 VDC supply to the Bird Dog power cable.  

 

• Connect the True Reference Signal (Pilot signal) from the vibrator electronics or encoder 

to the 1 REF BNC on the Bird Dog. 

 

• Connect the Time Break input from the vibrator electronics or encoder to the TB 1 

TRIGGER BNC  input on the Bird Dog. 

 

• Connect the independent accelerometers to the VibQC the 2 and 3 BNCs on the Bird Dog   

 

• The accelerometer mounted on the Baseplate of the vibrator should be connected to BNC 

2. 

 

• The accelerometer mounted on the Reaction Mass of the vibrator should be connected to 

BNC 3. 

 

• The independent accelerometers should be mounted as close to the accelerometers 

connected to the control electronics as possible. 

 

• Magnetically mounting of the independent accelerometers may not be secure enough for 

good QC testing.  To help making the mounts secure: 

• Make sure the surface is flat. 

• Clean the surface. 

• It may be necessary to scrape the paint from the surface. 

• It may be necessary to use mounting studs instead of magnets on some locations. 

 

• When using the independent magnetic accelerometers, the power supplies in the Bird 

Dog must be turned on.  This is done by selecting Magnetic Acc QC mode in the DAQ 

Configuration/Acquisition menu. 

 

• Run the VScope or Souce Signature program.  See the Quick Start or Source Signature 

Program sections of this manual for additional information. 

 

• Select Magnetic Acc mode in the DAQ Configuration/Acquisition menu. 

 

• Make sure the CURR REG LED is on. 

 

• When using the supplied independent accelerometers, the Weights and Accelerometer 

Sensitivity settings must be correct in the DAQ Configuration/Vibrator menu.  The 

supplied accelerometers have a 10mV/g sensitivity.  

 

• Acquire, analyze, and store data. 



Force III Data Acquisition 

The following can be done an any order: 

 

• Connect the Ethernet cable from the Force III unit to the computer. 

 

• Connect the Force III to DC power and turn it on. 

 

The following must be done in this order: 

 

1.Start the Source Signature program. 

 

2.In the Options/Preferences/General menu, Advanced Mode not selected. 

 

3.Open the DAQ Setup menu.  See the DAQ Setup section. 

 

4.Enable and select the Bird Dog that is connected to the computer.  If it does not appear, 

see the Ethernet Setup section.  (IP Address 10.0.0.101; Subnet mask 255.0.0.0; firewalls 

off; TCP/IP Verification off) 

 

5.Select Force III Mode. 

 

6.Enable the channels to be used. 

 

7.Sample Rate, Acquisition Time and trigger mode are not used. 

 

8.Vibrator settings are not used. 

 

9.OK & Close  

 

10.Start a sweep. 

 

11.Check for signals on all channels in a Signal Traces plot in the Seismic, Vertical mode 

to ensure signals are received. 

 

12.Analyze signals using desired plots. 

 

13.Save the data 

 

Repeat the procedure, starting with setp 10, “Start a sweep” to acquire additional data if 

desired. 
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  Detailed Quick Start - Force III Data Acquisition 

The following can be done an any order: 
• Connect the Ethernet cable from the Force III unit to the computer. 

• Connect the Force III to DC power and turn it on. 

 

 

The following must be done in this order: 
1.Start the Source Signature program. 

2.In the Options/Preferences/General menu, make sure the Advanced Mode is not 

selected. 

3.In the Options/Preferences/ other menus, set them as you prefer. 

4.Click on the OK button at the bottom of the Preferences window. 

5.Press the D key on the computer keyboard.  Notes:  1.  This is the same as clicking on 

the Device button in the Options menu or clicking on the Device button at the right end 

of the tool bar.  2.  This should open the DAQ Setup window. 

6.If the Force III you are connected to appears in the DAQ Setup window make sure the 

box to the left of the Force III's serial number is checked and the line containing the serial 

number and IP address is highlighted (yellow background, black text). 

7.If the Force III does not appear, click on the Auto Detect button.  

8.If it does not appear, check on the TCP/IPv4 Properties.  Set the IP address for the 

computer to something like 10.0.0.101 and subnet mask to 255.0.0.0 then try the Auto 

Detect again. 

9.Click on DAQ Settings.  The progress bar should stop after going about ½ way across 

the window and the Configuration window should appear. 

10.Left Click on the Force III Mode. 

11.Enable the channels you plan to use in the Channels window.  Enabling all channels 

is recommended. 

12.Sample Interval, Acquisition Time, Display Units, and Trigger Options are not used in 

this mode. 

13.The settings in the Vibrator tab are not used in this mode. 

14.If a GPS receiver is connected to the Force III unit, click on the GPS tab then on the 

Get Position button to make sure the GPS receiver is sending time and position data to 

the unit. 

15.Click on the OK button at the bottom of the Configuration window and the 

Configuration window should close. 

16.Click on the Close button at the bottom of the DAQ Setup window. 

17.In the Options/Auto Download menu, select VSS DAT Files. 

18.Near the bottom of the Source Signature program window, click on the STATUS tab. 

19.Start a sweep. 

20.“triggered” should appear in the Status window, at the bottom of the Source 

Signature window. 

21.“Recording: NNs” should appear to the right of the Tx light.  NN is a counter 

counting up the seconds of acquisition.a 

22.The STATUS LED on the unit should come on and stay on until the sweep ends. 

23.There should be some activity on the Rx and Tx lights, at the bottom of the Source 



Signature window.  The Rx light should come on for a longer time after the sweep is 

finished, while the BD3 downloads data to the computer. 

24.“Recording…” should appear to the right of the Tx light while data is downloaded 

from the Force III while it is sweeping. 

25.Looking at all channels in a Signal Traces plot in the Seismic, Vertical mode would 

be a good starting place, to see that all the expected channels have signal on them. 

26.Open plot windows and plot data as desired to analyze the vibrator’s performance. 

27.After a good similarity is received, do Ctrl+S to start the file save function. 

28.Enter desired text in the Save window then press the Yes button. 

29.Enter a path and file name in the Save As window. 

30.Select the file type in the Save as type window using the pull-down button to the right 

end of that window. 

31.Click on the Save button. 

Repeat the procedure, starting with setp 19, “Start a sweep”, to acquire additional data if 

desired. 
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Downloading Data from BD3-11 
A very useful feature of a Bird Dog 3-11 unit is that it stores the data it records.  The data 

files may be downloaded later.  Files have the time and date they were acquired saved.  

This is UTC (Greenwich Mean Time) and date.  To download data files: 

The following can be done an any order: 

 

• Connect the Ethernet cable from the Bird Dog unit to the computer. 

 

• Power the Bird Dog unit up  

 

• Connect the Force III to DC power and turn it on. 

 

The following should be done in this order: 

1.Connect the computer with Source Signature running to the unit.  See the Detailed 
Quick Start section for more information. 
 
2.In the File pull-down menu, select Load From Unit. 

 

3.An FTP Explorer window should open. 

 

4.The number and IP address of the device may appear in the Unit ID window and 

00000000, SWEEPS, TEST may appear in the Folders window.  If this happens, the 

computer is communicating with the unit.  If not, refer to the detailed procedure for 

instructions about how to connect to the unit. 

 

5.Left click on 00000000 to open the Folders window. 

 

6.The data files that unit has acquires should be listed in the "Files In Current Folder" 

window. 

 

7.Scroll up or down to locate a file that appears to have been acquired at the time and 

date of interest. 

 

8.Left clicking on the file will cause the current plots to show data from that file.  

 

9.To download one or more data files, use the typical Shift+left click or Ctrl+left click to 

highlight the desired files. 

 

10.Right click while the cursor is on one of the highlighted files.  This will open the File 

Control Window, shown in the example below. 

 

11.Left click on Download in the File Control Window. 
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12.A "Select a Folder" window will open.  An existing folder may be selected or a new 

folder may be made.   

 

13.Highlight a folder then click on OK at the bottom of the Select a Folder window. 

 

14.The selected data file(s) should be copied to the selected folder. 

 

 

 

 

  Detailed Quick Start Downloading Data from Bird Dog 3-11  

 
A very useful feature of a Bird Dog 3 unit is that it stores the data it records.  The data 
files may be downloaded later.  Files have the time and date they were acquired saved.  
This is UTC (Greenwich Mean Time) and date.  To download data files: 
 
1.  Use the Ethernet cable to connect the computer with Source Signature running to the 
unit. 
2.  Connect the unit to DC power. 
3.  In the File pull-down menu of Source Signature, select Load From Unit. 
4.  An FTP Explorer window should open.  An example of that is shown below. 
5.  Establish communications between Source Signature and the Bird Dog unit: See the 
Unit ID section below. 
6.  If communications is established, a list of folders should appear in the Device Folders 
window.   
7.  If that list shows: 
DAQ3 
FORCE3 
SELFTEST 
SYS-LOG 
 
Click on DAQ3 
8.  The list should then show: 
00000000 
SWEEPS 
TESTS 
There may be more than one folder named 0000000X where the X is a different number 
for multiple folders. 
9.  Left click on 0000000X to open one of those folders. 
10.  The .DAT data files that unit has acquires should be listed in the "Files In Current 
Folder" window. 
11.  Scroll up or down to locate a file that appears to have been acquired at the time and 
date of interest. 
12.  Left clicking on the file will cause the current plots to show data from that file.  
13.  Left clicking on another file will cause data from that file to be shown.  By using this 
technique, one may preview and select a particular file. 



14.  The file may then be saved using the File Save feature. 
15.  To download one or more data files, use the typical Shift+left click or Ctrl+left click to 
highlight the desired files. 
16.  Right click while the cursor is on one of the highlighted files.  This will open the File 
Control Window, shown in the example below. 
17.  Left click on Download in the File Control Window. 
18.  A "Select a Folder" window will open.  An existing folder may be selected or a new 
folder may be made.   
19.  Highlight a folder then click on OK at the bottom of the Select a Folder window. 
20.  The selected data file(s) should be copied to the selected folder. 
21.  Messages in the Status Window will indicate the operation was done, as shown in 
the example below. 
22.  The files may be converted to SEG-Y by using the File/Convert Files... feature in 
Source Signature. 
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Navigation Tools 

 
Allows navigation to a previous folder, up one folder level, or to return to this 
site's home folder.  

 

Device Folders 

 
Shows the folders inside the currently selected folder.  In this example, there are 
no folders in the currently selected folder.  If there were, the folders inside this 
folder would appear here.  If the window looks similar to this: 

the computer is connected to the Bird Dog 3-11 unit.  Left click on 
the line showing 00000000 to open the folder containing the stored files. 

 
 

 

Unit ID 

 
The unit connected to will appear here if the computer is currently connected to 

the unit.  In this case, the Connect/Disconnect button  will be highlighted, 
with a tan background.  If the unit is not currently connected to a unit, left clicking 
on the pull-down arrow will open the list of units previously detected.  It should 
look similar to this: 

 
If the unit currently connected to the computer appears, left clicking on the unit's 
listing then left clicking on the Connect/Diconnect button will initiate the 
connection process.  If the unit is not in the list, left clicking on the Detect button 
should cause the program to detect the unit and it should then appear in the 
window.  If the unit is not detected, check the Ethernet cable and the TCP/IP 
settings. etc.  Canceling the download and detecting the unit by opening the 
Options/Device/Auto Detect function may help if the unit cannot be detected 
using the Detect button.  Once the unit appears in the list, left click on it then left 



click on the Connect/Disconnect button.  When the unit is connected, test should 
appear in the Device Folders and Status windows.  If the Status Window shows 
connected then disconnected and an error message appears.  Try disconnecting 
the Ethernet cable, then starting a download but selecting a different Unit from 
the pull down menu, then canceling the download, then reconnecting the 
Ethernet cable to the unit, then trying a download again.  

 

Device Connection Tools 

 
Shows the serial number and IP address of the unit the computer is connected 
to, has connect/disconnect (toggle) and Detect buttons for breaking or 
establishing FTP connection with a unit.  

 

Files In Current Folder 

 
File(s) in the Current Folder window may be selected using typical  Left Click, 
Shift+Left Click, or Ctrl+Left Click functions.  Right clicking on a selected file will 
open the File Control window.  Left clicking on Download in this window will 
initiate the file download process. 
 

 

 Status Window 

 
A brief history of operations completed. 

 

Status bar 
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Shows the current status. 

 

Load button 

 
Load the selected file. 

 

Cancel button 

 
Close the FTP Explorer window 

 

File Control Window 

 
Click on Download to start the procedure to download selected file(s).   



Downloading Data from Force III Unit 

 
A very useful feature of a Force III unit is that it stores the reference, sim 
accelerometers, and ground force signals in .DAT files.  Also, the Force III may store 
.VIB records of Vibrator QC data for the current day.  The .DAT or .FMR files may be 
downloaded using the Source Signature program. 
 
1.  Connect the Ethernet cable from the computer to the Force III unit. 
 
2.  Power the Force III unit up.  
 
3.  In the File pull-down menu of Source Signature, select Load From Unit.  See the 
Detailed Quick Start section for more information. 
 
4.  Establish communications between Source Signature and the Bird Dog unit: See the 
Unit ID section below. 
 
5.  If necessary, use the navigation buttons to find the .DAT or .VIB files of interest. 
 
6.  Select the File(s) to be downloaded. 
 
7.  To download one or more data files, use the typical Shift+left click or Ctrl+left click to 
highlight the desired files. 
 
8.  Right click while the cursor is on one of the highlighted files.  This will open the File 
Control Window, shown in the example below. 
 
9.  Left click on Download in the File Control Window. 
 
10.  Right click while the cursor is on one of the highlighted files.  This will open the File 

Control Window, shown in the example below. 

 

11.Left click on Download in the File Control Window. 

 

12.A "Select a Folder" window will open.  An existing folder may be selected or a new 

folder may be made.   

 

13.Highlight a folder then click on OK at the bottom of the Select a Folder window. 

 

14.The selected data file(s) should be copied to the selected folder. 
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Detailed Quick Start Downloading Data from Force III Unit 

 
A very useful feature of a Force III unit is that it stores the reference, sim 
accelerometers, and ground force signals in .DAT files.  The unit stores many of these 
files.  If the storage gets nearly full, some of the oldest data will automatically be erased.  
Also, if the Force III SERVICE/TESTS/VIB RECORD menu item is set to ON, the Force 
III will keep .VIB records of Vibrator QC data for the current day.  The .VIB files are 
automatically erased each day.  The .DAT or .FMR files may be downloaded later.  Files 
have the time and date they were acquired saved.  This is UTC (Greenwich Mean Time) 
and date.  To download data files: 
 
1.  Use an Ethernet cable to connect the computer with Source Signature running to the 
Force III unit. 
2.  Power the Force III unit up.  It only needs to be powered up.  It does not need to be in 
the operate mode. 
3.  In the File pull-down menu of Source Signature, select Load From Unit. 
4.  An FTP Explorer window should open.  An example of that is shown in this section of 
the manual. 
5.  Establish communications between Source Signature and the Bird Dog unit: See the 
Unit ID section below. 
6.  A list of folders should appear in the Device Folders window.   
7.  If that list shows: 
DAQ3 
FORCE3 
SELFTEST 
SYS-LOG 
 
Click on DAQ3 to download .DAT files containing only reference, accelerometer, and 
force signals or click on FORCE3 to download .VIB files that contain more signals. 
8.  If DAQ3 was selected, the list should then show: 
00000000 
SWEEPS 
TESTS 
 
If FORCE3 was selected, see the Device Folders section, below. 
9.  Left click on 00000000 to open that folder. 
10.  The data files that unit has acquires should be listed in the "Files In Current Folder" 
window. 
11.  Scroll up or down to locate a file that appears to have been acquired at the time and 



date of interest. 
12.  Left clicking on the file will cause the current plots to show data from that file.  
13.  Left clicking on another file will cause data from that file to be shown.  By using this 
technique, one may preview and select a particular file. 
14.  The file may then be saved using the File Save feature. 
15.  To download one or more data files, use the typical Shift+left click or Ctrl+left click to 
highlight the desired files. 
16.  Right click while the cursor is on one of the highlighted files.  This will open the File 
Control Window, shown in the example below. 
17.  Left click on Download in the File Control Window. 
18.  A "Select a Folder" window will open.  An existing folder may be selected or a new 
folder may be made.   
19.  Highlight a folder then click on OK at the bottom of the Select a Folder window. 
20.  The selected data file(s) should be copied to the selected folder. 
21.  Messages in the Status Window will indicate the operation was done, as shown in 
the example below. 
22.  The files may be converted to SEG-Y by using the File/Convert Files... feature in 
Source Signature. 
 

 
 

 
 

File Pull-Down/Load from Unit 
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Left click on Load from Unit to initiate the FTP Explorer process. 

 

FTP Explorer 

 
 

 

Unit ID 

 



The unit connected to will appear here if the computer is currently connected to 

the unit.  In this case, the Connect/Disconnect button  will be highlighted, 
with a tan background.  If the unit is not currently connected to a unit, left clicking 
on the pull-down arrow will open the list of units previously detected.  It should 
look similar to this: 

 
If the unit currently connected to the computer appears, left clicking on the unit's 
listing then left clicking on the Connect/Diconnect button will initiate the 
connection process.  If the unit is not in the list, left clicking on the Detect button 
should cause the program to detect the unit and it should then appear in the 
window.  If the unit is not detected, check the Ethernet cable and the TCP/IP 
settings. etc.  Canceling the download and detecting the unit by opening the 
Options/Device/Auto Detect function may help if the unit cannot be detected 
using the Detect button.  Once the unit appears in the list, left click on it then left 
click on the Connect/Disconnect button.  When the unit is connected, test should 
appear in the Device Folders and Status windows.  If the Status Window shows 
connected then disconnected and an error message appears.  Try disconnecting 
the Ethernet cable, then starting a download but selecting a different Unit from 
the pull down menu, then canceling the download, then reconnecting the 
Ethernet cable to the unit, then trying a download again.  

 

Device Connection Tools 

 
Shows the serial number and IP address of the unit the computer is connected 
to, has connect/disconnect (toggle) and Detect buttons for breaking or 
establishing FTP connection with a unit. 

 
 

Device Folders 

 
Folders in the current folder will be displayed here.  If 00000000, and possibly 
00000001, and possibly more and then TESTS appears in this window, files 
containing refrence, sim accelerometers, and sim ground force may be opened 
by selecting one of the 0000000X folders. 
  



Bird Dog 3-11 
 47 

The up and left arrow buttons may be used to navigate to other folders.   
 
If connected to a Force III unit, navigating up one folder should change the 
Device Folders to something similar to this: 

 
Left clicking on FORCE 3 should change the Device Folders to something like 
this: 

 
Left clicking on RECORDS should change the Device Folders to something like 
this: 

 
If the Force III SERVICE/TESTS/VIB RECORD menu item is set to ON, the 
Force III will keep records of Vibrator QC data for the current day.  The folder 
name will be the current data.  2014, Frebruary 14 is the date shown in this 
example.  The data is automatically erased each day.  The data in these files will 
include Reference, singals from all four accelerometers, loop and sim ground 
force, and vibrator control signals such as torque motor current, valve and mass 
feedback, etc.  

 

Files In Current Folder 



 
Files may be selected from this area for downloading.  The DAQ folder will have 
.dat files, which contain only ref, acc, and force data.  The 
FORCE3/RECORDS/Date folder will have .vib files, which contain the data in 
.dat files plus vibrator control data, only if sweeps have been taken while the 
Force III SERVICE/TESTS/VIB RECORD menu item is set to ON. 
This is an example of .DAT files in Files in Current Folder window. 

 
Here is an example of .VIB files in the Files in Current Folder window. 

 
 

Status Window 

 
Shows a brief history of operations completed. 

 

Status bar 

 
Shows the current FTP communications status. 
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  BD3-11 with Sercel VE464 
 

The following diagram shows various connections with the VE464 

 
 

The VE464 wireline test and the VE464 Single vibrator connections require special scaling of the 

accelerometer signal as shown in the following paragraphs. 

 

When using the external independent accelerometers the correct 10 mv/G sensitivity of the 

accelerometer must be entered and the correct weights of the vibrator must be entered. 

 



The BD3-11 can also be used to perform a wireline similarity of 5 vibrators at one time 

 
 

Anytime the signals are produced directly from the VE432/VE464 then the accelerometer scaling 

must be adjusted as shown in the following paragraphs. 
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VE464 connection 

Connect the 14 pin connector to the Similarities connector on the top of the Sercel VE464, 

connect the BNC to the TB (Time Break) connector on the Sercel VE464, and connect the 55 pin 

connector to the 55 pin connector on the BD3-11 unit. 

The Time Break signal from the VE464 is zero volts when the unit is not sweeping and about 3.3 

volts when the unit is sweeping.   

Ch 1 - Reference Sweep 

Ch 2 – Weighted Sum approximation of Ground Force 

Ch 3 – Reaction Mass Force  

Ch 4 – Baseplate Force 

 
 

 

Setup the BD3-11 to trigger on positive edge of the TB signal 



 
 

 

 



Bird Dog 3-11 
 53 

The following description is from the Sercel VE464 manual 

 
 

 



To show the correct Output Force in Pounds, go to the Options- Device - DAQlink Setting menu 

and setup the channels for the following Scale and units 

 

 
After acquiring a new record an additional LGF signal will appear in the list.  This “Loop Ground 

Force” signal will be the combination of channel 3 (LRM) and channel 4 (LBP).  The new LGF 

signal should be identical to channel 2 from the VE464. 
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  Source Signature Program 
Source Signature Installation 
 
The recommended ways to install Source Signature are: 

• As part of an installation from the Seismic Source Software installation. 
• Manually installed from files downloaded from SSC (Seismic Source Company), 

etc. 
 
Seismic Source Software Installation 
 
During the installation process, include Source Signature and other items you desire to 
be installed. 
 
 
Manual Installation 
 
Windows 7: 
 

• Download and install WinPcap.  That can be downloaded from the WinPcap 
website at http://www.winpcap.org/install/ or other sites such as CNET. 

The instructions from WinPcap at are: 
1.     Download and run the executable 
2.     Follow the instructions on the screen. The installation applet will automatically 

detect the operating system and install the correct drivers 
3.     The WinPcap-based applications are now ready to work 
4.     To remove WinPcap from the system, go to the Control Panel, click on 

"Add/Remove programs" and then select "WinPcap" 
 
With Windows 8,  
1. Download winpcap.. www.winpcap.org 
2. Right click on this file ---> WinPcap_4_1_2.exe 
3. Click properties, then click the compatibility tab 
4. Under compatibility mode, use the dropdown box to choose windows 7 
5. Click apply and save. 



 
 
 
 

• Download the desired Source Signature file.  It is likely to be a compressed file, 
such as srcsig212.zip.  That file is typically about 4MB so it may be too large to 
attach to an email, so a link to the SSC FTP site for automatic download may be 
sent to you.  

• If the file is compressed, uncompress it.  The resulting file should be something 
like srcsig.exe and should be about 11MB. 

• Save srcsig.exe in the directory of your choice. 
• Start Source Signature using the technique normal to your operating system. 
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  Ethernet Setup 
TCP/IPv4 Settings 
 
Before the Computer can be connected to the Bird Dog 3-3 unit, it is necessary to setup the 

Ethernet port.  Normally, it is necessary to set up a fixed TCP/IPv4 address for the computer to 

communicate with the Bird Dog 3-3 unit. 

 

IPv4 Address SET to FIXED IP ADDRESS – 10.0.0.101 

 

Subnet mask set to 255.0.0.0 

 

All Firewalls Disabled 

 
 

Changing To A Different Computer 
 
If the Bird Dog 3-3 unit was previously communicating with a computer with a different address, 

then the Bird Dog 3-3 unit must be reset (power off then on) for the unit to communicate to the 

computer with the new address. 

 

 

 

Authentication 
With some of the Windows versions there is an additional Authentication Tab.  The 

Authentication must be disabled to operate with the Bird Dog 3-3 unit. 

 

 

 

Additional Ethernet Setup Information  
 
See Additional Ethernet Setup Information section near the end of this manual for more 

information about setting up the Ethernet connection. 



  Source Signature Program Operation 

 
 

Title Bar 

 
Contains the program name and version along with typical windows applications 
control buttons to close the program, etc.     

 

Pull-Down Menus 

 
Typical menus to access the program's features. 

 

Tool Bar 

 
Buttons for quick access to many of the program's commonly used features. 

 

Plot Area 
 
Various plots the program can generate can be displayed in this area. 

 

Information Field 
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Various kinds of information about the data and program status can be displayed 
here. 

 

Status Bar 

 
Receiving and transmitting data and recording progress messages are displayed 
in this bar. 



  File Pull-Down Menu  

 
 

 

Clear Data Currently Loaded 

 
Removes data currently in the program buffer.  Does not delete any saved files. 

 

Open A Saved Data File 

 
A standard operating system Open function. 

 

Save Data Currently In Buffer To A File 

 
A standard operating system Save function. 

 

Load Data From The Unit The Computer Is Currently Connected To 

 
Opens a dialog to load data from a Bird Dog 3-11 VibQC, a Force 2, or other 
kind of unit.  Allows the user to detect the unit(s) the computer is connected to.  
Also allows one to see a listing of the files saved on the unit, see plot previews 
for the files, and download one or more files. 

 

Convert Files 
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DAT files downloaded from a unit to SEG-Y format. 
 

Print Screen 

 
A standard operating system Print Screen function. 

 

Print Setup 

 
A standard operating system Print Setup function. 

 

Exit 

 
A standard operating system Exit function. 



  Load From Unit Menu 

 
 

Navigation Tools 

 
Tools to move up a folder, back, etc. 

 

Device Connection Tools 

 

The device window  shows the device connected to or a 
list of devices the program has been connected to by clicking on the pull-down 

button in that window.   

Left click on the connect/disconnect (toggle) button  to connect or 
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disconnect the computer to/from the unit in the device shown in the device 
window.  When the background of this button is white, the unit is disconnected.  
When the background is tan, the unit is connected.   

Left click on the Detect button  for the computer to detect the unit it is 
connected to and to open the Device Folder window to the initial folder.   

 
 

Device Folders 

 
 
Shows the folders available from the folder currently connected to. 

 

Files In Current Folder 
 

 

 
Shows the files in the folder currently connected to. 
If enough files are in the current folder, a scroll bar will appear on the right side of 
the window for moving up and down in the list of files. 
Files may be sorted by clicking on the File Name, Size, and Date fields. 
Data from a single file may be loaded by left clicking on the file name, size, or 
date then left clicking on the Load button. 



One or more files may be selected by left clicking, shift+left clicking, or ctrl+left 
clicking on files. 
One or more files may be downloaded from the unit to the computer by right 
clicking with the cursor is in the file list window title bar or on one of the selected 
files. 
 

 

 Status Window 

 
Shows a brief history of events. 

 

Status bar 

 
 

 

Load button 

 
 

 

Cancel button 
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  Download Files 

 
 

Files In Current Folder Window 

 
 

 

File Transfer Control Window 

 
Left click on Download to copy selected files to open the Select a Folder window. 
 
 
 



  File Types 

Source Signature input files are .DAT and .VIB.  DAT files may be imported from a Bird 
Dog unit or from a Force III unit by connecting to the unit via the File/Load from Unit... 
function. 
 
DAT files from a Force III will contain Reference and sim Baseplate and Reaction Mass 
acceleration and Ground Force signals.  Dat files from a Bird Dog 3-3 or 3-11 unit will 
contain as many signals as were recorded in each file, e.g. 8 recorded data traces plus 
two more Ground Force signals for VibQC files; 2 for Zero Time files, encoder and 
decoder references.  
 
VIB files may only be downloaded from a Force III.  VIB files have Reference, Loop and 
Sim Baseplate, and Reaction Mass Accelerometer signals, Loop and Sim Ground Force, 
Torque Motor, Valve and Mass Displacement, and Drive.  
 
VIB files are are automatically deleted from Force III units as the GPS date increments. 
 
To enable storage of VIB files, in the Force III menus, go to SERVICE/TESTS/VIB 
RECORD and select ON, then return to the main operating screen and take one or more 
sweeps. 
 
To download VIB files, in Source Signature, use the File/Load from Unit... function.  
When connected to a Force III, the first Device Folders window should look similar to 
this: 

 
Left click on the up arrow button to go up one folder level.  Then the Device Folders 
window should look similar to this: 
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Double left click on FORCE3 to open the FORCE3 folder.  Then the Device Folders 
window should look similar to this: 

 
Double left click on RECORDS to open the RECORDS folder.   Then the Device Folders 
window should look similar to this: 

 where the folder shown is the current GPS date. 
Double left click on the date to open the date folder.  Then the Device Folders window 
should be empty and the Files In Current Folder should show a listing of the saved VIB 
files.  It may  look similar to this: 

 
Double left clicking on a .VIB file will open that file into Source Signature. 
 
Source Signature will support analysis and storage of the data. 
 
 
 
 
 
 



  Select a Folder window 

 
 

Make New Folder button 

 
 

 

Folders In The Currently Open Folder 

 
 

 

OK button 

 
After selecting the desired destination folder, left click here to start the file copy 
function. 
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Cancel button 

 
 



  File Converter window 

 
 

Input File Type 

 
Select the type of file to be converted. 

 

Select The Source Folder 

 
Select the folder where the files to be converted are located. 

 

Output File Type 

 
At this time, only SEG-Y file type is available. 
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Destination Folder 

 
Select the folder the converted files should be written to. 

 

Start button 

 
 

 

Stop button 

 
 

 

Close Button 

 
Closes the File Converter window 

 

Status 

 
Shows the status/progress of the file conversion process. 



  View Pull-Down Menu 

 
 

Most of the functions in the View pull-down menu are also on the Tool Bar.  The Tool 
Bar has a few functions not found here. 
 

New Plot 

 
Adds a plot window to the Plot Area 

 

Noise View 



Bird Dog 3-11 
 73 

 
Opens a Noise View window that should look something like this: 

 
Right clicking in the graph section will open the window that provides access to 
Axis, Full View, RMS, etc. functions.  

 

Plot Axis control 

 
Opens a window to allow changing the axes of the currently selected plot. 

 

Plot Axis Zoom Out 

 
Sets the axes of the currently selected plot to be great enough to show the 
complete plot of the currently displayed data.  

 

Invert Signal Data 

 
Inverts the signal data for display purposes only, not for saving data.  Will cause 
phase plot to toggle between 0 and 180 degrees, etc.  Does not invert the 
reference signal. 

 

Remove DC 

 
Removes D.C. offset from all signals. 

 

Smooth Plots 



 
Smooths all data for most types of plots. 

 

Low Cut Filter 

 
Enables or disables the low cut filtering of data.  See the 
Options/Preferences/Filters to set the frequency of the Low Cut Filter. 

 

High Cut Filter 

 
Enables or disables the high cut filtering of data.  See the 
Options/Preferences/Filters to set the frequency of the High Cut Filter. 

 

Notch Filter 

 
Enables or disables the notch filtering of data.  See the 
Options/Preferences/Filters to set the frequency of the Notch Filter. 

 

Auto Plot Overlay 

 
Captures the current plots so that newer data plots overlay the current plots. 

 

Clear Overlays 

 
Removes the captured overlays from the plots. 

 

Signal Traces 

 
Converts the currently selected plot to a Signal Trace (oscillograph, commonly 
called wiggle trace) of all the signals selected for that plot.  The plot can be 
configured several ways.  
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Spectrum Analysis 

 
Converts the currently selected plot to a Spectrum Analysis Plot of all the signals 
selected for that plot.  The plot can be configured several ways.  

 

Correlation 

 
Converts the currently selected plot to a Correlation Plot of all the signals 
selected for that plot.  The plot can be configured several ways.  

 

Vib Analysis 

 
Converts the currently selected plot to a Vib Analysis Plot of all the signals 
selected for that plot.  The plot can be configured several ways and can include 
phase, fundamental force, absolute peak force, etc. plots. 

 

Distortion 

 
Converts the currently selected plot to a Distortion Plot of all the signals selected 
for that plot.  The plot can be configured several ways.  

 

Compare Signals 

 
Converts the currently selected plot to compare selected plots, e.g. plotting 
reference versus baseplate phase, etc.  This can be a phase or amplitude 
comparison,  



  Edit Pull-Down Menu 

 
 

 
 

Comment 

 
Allows editing of comments to be saved with data when saving a file. 

 

Processing Window 

 
Allows one to have some of the data not plotted.  The start and/or end amounts 
of plot suppression can be defined. 

 

Preferences 

 
Opens the application Preferences setup window.  Can also be accessed 
through the Options pull-down menu. 
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  Acquisition Menu 

 
 

 
 

Start Acquistion 

 
Enables data acquisition when used wth a Bird Dog 3-11 VibQC unit.  Pressing 
the A key on the keyboard also enables acquisition.  Acquisition starts 
automatically at start of sweeps when connected to a F3.   

 

Stop Acquisition 

 
Stops data acquisition when used wth a Bird Dog 3-11 VibQC unit.  Pressing the 
ESC key on the keyboard also stops acquisition.  The Stop button has no effect 
when connected to a F3.   



  Options Menu 

 
 

 
 

Device 

 
Opens the Deice window, for selecting and configuring devices that the computer 
may be connected to. 

 

Auto Download 

 
Opens the window to automatically download VSS (3 channel) or VibQC (11 
channel) data or to disable Auto Downloads.  The Disable function does not 
currently work properly. 

 

Preferences 

 
Opens the application Preferences setup window.  Can also be accessed 
through the Edit pull-down menu. 
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  DAQ Setup window 

 
 

Add... button 

 
Allows one to add a serial number and IP address manually. 

 

Remove button 

 
Allows one to remove a highlighted unit. 

 

Auto Detect button 

 
If a unit's serial number and IP address is not known, connect it to the compter 
then click on the Auto Detect button.  If communications can be established, the 
unit's serial number and IP address will appear in the Unit Identification window. 

 

DAQ Settings button 

 
Downloads the settings of the selected unit.  The unit's settings may be edited 
and sent to the unit from the DAQ Settings window. 

 



Copy To All button 

 
Copies the settings to multiple units.   Multiple units may be connected through 
an Ethernet Switch, etc. 

 

IP Settings button 

 
Opens a window that will allow changing the IP settings of the connected unit. 

 

Unit Acquistion Enable 

 
Signals from all units with this field checked will be acquired. 

 

Unit Identification 

 
Each detected unit's serial number and IP address will be displayed here.  
Selecting a unit will highlight this field, as shown for 5073 in this example.  The 
selected unit will be configured when DAQ Settings is selected. 
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  Configuration - Acquisition 

 

 
 

Unit Configuration 
 

Title Bar 

 
Shows the number of the Unit being configured and has the exit button for the 
configuration function. 

 

Acquisition tab 

 
Opens the window for acquistion configuration setup, as displayed in this 
example. 

 

Vibrator tab 

 
Opens a window for setting vibrator weights, etc. 

 



GPS tab 

 
Opens a window for checking the current GPS position information. 

 

Vibrator QC option 

 
Select this option for connecting the unit to a vibrator control unit. 

 

Wireline option 

 
Select this option for conducting wireline similarities by connecting wireline 
similarity cables from the vibrators' connector panels to the unit. 

 

Zero Time 

 
Select to conduct zero time tests. 

 

Magnetic Acc option 

 
Select for connecting independent magnetic mount accelerometers to any of 
inputs 2 through 11. 

 

Force III option 

 
Select for connecting the unit to a Force III unit by Ethernet. 

 

 Signals List 

 
Click to enable or disable signal inputs.  Move the slider at the bottom of this 
window to see all the signals available.  This example shows the Wireline 
Signals List.  It is best to only enable active signals for acquisition. 
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Sample Interval 

 
Allows selection of the sample interval for signals applied to the unit. 

 

Acquistion Time 

 
Allows selection of the length of acquisition time. 

 

Display Units 

 
Allows the graphs scaling to be displayed in different units. 

 

Auto Trigger option 

 
Select for the unit to start acquisition as soon as the START button is pressed. 

 

Trigger On TimeBreak option 

 
Select for the unit to start acquisition when the Time Break input signal arrives. 

 

Trigger On Reference option 

 
Select for the unit to start acquisition when the reference signal becomes active. 

 

OK button 

 
Applies the entries and exits the configuration function. 

 

Cancel button 

 
Exits the configuration function with out applying the entries. 



  Configuration - Vibrator 

 
Must be configured when using a Bird Dog 3-11 Vib QC unit in the Vibrator QC or 

Magnetic ACC modes.   
Not used in Wireline, Zero Time, or Force III Modes. 

 
 

Vibrator tab 

 
Select this tab to set vibrator parameters 

 

Vibrator Type 

 
The type of vibrator may be displayed here.  It is not necessary. 

 

Load button 

 
Loads vibrator parameters from a file. 

 

Save button 
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Saves vibrator parameters to a file. 

 

Reaction Mass Weight 

 
Enter the reaction mass weight.  Any units are acceptable as long as reaction 
mass, base plate, and hold down weights are all in the same weight system. 

 

Base Plate Weight 

 
Enter the base plate weight.  Any units are acceptable as long as reaction mass, 
base plate, and hold down weights are all in the same weight system. 

 

Hold Down Weight 

 
Enter the hold down weight.  Any units are acceptable as long as reaction mass, 
base plate, and hold down weights are all in the same weight system. 

 

Accelerometer Sensitivities 

 
System accelerometer sensitivites.  Seismic Source system accelerometers all 
have 25mv/g sensitivity.  Magnetic mount accelerometers typically have 10mv/g 
sensitivity. 

 

Apply button 

 
 

 

OK button 

 
Applies any changes and exits the window. 



 

Cancel button 

 
Exits the window without appliyng any changes that have been made. 
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  Configuration - GPS 

 
 

GPS tab 

 
 

 

Most recently received GPS data 

 
Left click on the Get Position button to load data from a GPS unit.  Data can be 
viewed to see if it appears to be valid.  This display shows a valid message. 

 

Decoded GPS Data 

 
Will show the position, time, and date if valid GPS data is being received.  Will 



show N/A if GPS data is not valid or not being received. 
 

GPS Port Baud Rate 

 
Select a different baud rate if the GGA string does not appear correctly after 
selecting Get Poistion. 

 

Apply GPS Config button 

 
 

 

RTI Baud Rate 

 
For settig the baud rate for sending data to the recording system. 

 

Apply RTI Config button 

 
 

 

Get Position button 

 
 

 

Cancel button 

 
 

 

OK button 
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  Vibrator QC Mode 

 
 

Vibrator QC option 

 
Attention!  The power supply for accelerometer tests may be on when the Bird 
Dog unit is powered up if it was last used for a test requiring that power, e.g. 

Magnetic Accelerometer or Accelerometer Test modes.  Make sure the 
CURR REG LED is off before  connecting the unit to vibrator 
control units for Vibrator QC, Wireline, or Zero Time tests.  If the 
LED is on, the accelerometer testing power supply may be turned off by entering 
the DAQ Setup mode, then selecting one of these modes, and then by left 
clicking on the OK button at the bottom of the DAQ Configuration window. 

 

Signals Available For Acquisition 

 
Move the slider below this window to access all the signals that are available.  
Click on signals to enable or disable them for acquisition. 

 

Sample Interval 



 
From 0.021ms to 8 ms per sample, in preset intervals.  Channels 9, 10, and 11 
cannot sample faster than 0.25 msec. 

 

Acquisition Time 

 
 

 

Display Units 

 
Pounds, KG, or Newtons are the options. 

 

Trigger Options 

 
Triggering on TimeBreak usually gives the best results.  

 

OK button 

 
 

 

Cancel button 
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  Wireline Mode 

 
 

Wireline option 

 
Attention!  The power supply for accelerometer tests may be on when the Bird 
Dog unit is powered up if it was last used for a test requiring that power, e.g. 

Magnetic Accelerometer or Accelerometer Test modes.  Make sure the 
CURR REG LED is off before  connecting the unit to vibrator 
control units for Vibrator QC, Wireline, or Zero Time tests.  If the 
LED is on, the accelerometer testing power supply may be turned off by entering 
the DAQ Setup mode, then selecting one of these modes, and then by left 
clicking on the OK button at the bottom of the DAQ Configuration window. 

 

Signals Available For Acquisition 

 
Move the slider below this window to access all the signals that are available.  
Click on signals to enable or disable them for acquisition. 

 

Sample Interval 



 
Set as desired.  Channels 9, 10, and 11 cannot sample faster than 0.25 msec. 

 

Acquisition Time 

 
Set as desired. 

 

Display Units 

 
Set as desired 

 

Trigger Options 

 
Set as desired.  Trigger On TimeBreak recommended.  Pre and post trigger are 
available in the Advanced mode.  

 

Cancel button 

 
 

 

OK button 
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  Zero Time Mode 

 
 

Zero Time option 

 
Attention!  The power supply for accelerometer tests may be on when the Bird 
Dog unit is powered up if it was last used for a test requiring that power, e.g. 

Magnetic Accelerometer or Accelerometer Test modes.  Make sure the 
CURR REG LED is off before  connecting the unit to vibrator 
control units for Vibrator QC, Wireline, or Zero Time tests.  If the 
LED is on, the accelerometer testing power supply may be turned off by entering 
the DAQ Setup mode, then selecting one of these modes, and then by left 
clicking on the OK button at the bottom of the DAQ Configuration window. 

 

 Signals Available For Acquisition 

 
Ensure both signals are enabled. 

 



Sample Interval 

 
Select as desired.  1 or 2 msec recommended.   

 

Acquisition Time 

 
Set as desired.  Sweep length is recommended 

 

Display Units 

 
 

 

Trigger Options 

 
Set as desired. 

 

OK button 

 
 

 

Cancel button 
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  Force III Mode 

This is for situations where the Ethernet cable is connected to a Force III instead of a 
Bird Dog 3 unit. 

 

 
 

Force III option 

 
When connected to a Force III unit, this is QC mode will automatically be 
selected.  No others will be available. 

 

 Signals Available For Acquisition 

 
This is the only signals that will be shown, but if Vib QC Files is selected in the 
Options/Auto Download menu, signals like those acquired in typical VibQC 
operations will be recorded.  The Vib Record function must be set to ON in the 
SERVICE/TESTS menu on the Force III for the Vib QC function to work. 

 

Sample Interval 



 
Not used when connected to a Force III. 

 

Acquisition Time 

 
Not used when connected to a Force III.  Will automatically acquire data for the 
length of the sweep. 

 

Display Units 

 
Not used when connected to a Force III. 

 

Trigger Options 

 
Not used when connected to a Force III.  Will automatically trigger on Time 
Break. 

 

OK button 

 
 

 

Cancel button 
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  Magnetic Accelerometers Mode 

 
 

Magnetic Acc option 

 
Source Signature turns on power supplies for independent accelerometers for 
BNC inputs 2 through 5 when not in the advanced mode.  Power supplies can be 
turned on or off for these and other BNCs when in the advanced mode.  Power 
supplies are not available for channels 9, 10, and 11.  See the Mag Acc 
Advanced section of this manual for instructions. 

 

 Signals Available For Acquisition 

 
Other signals can be added in the advanced mode.  See the Mag Acc Advanced 
section for instructions. 

 

Sample Interval 

 
Set as desired 

 



Acquisition Time 

 
Set as desired 

 

Display Units 

 
Set as desired 

 

Trigger Options 

 
Set as desired.  Trigger On TimeBreak is recommended. 

 

OK button 

 
 

 

Cancel button 
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  Mag Acc Advanced Mode 

 
Advanced Mode in the Options/Preferences window offers many capabilities not 
available when Advanced Mode is not selected.  It is easy to accidentally make 
some changes to configuration settings while in the Advanced Mode.  These 
accidental setting changes may affect the program's operation in undesirable 
ways .  Most  configuration settings can be restored to proper entries by going 
into the not-Advanced Mode and then configuring the unit by going to the 
Options/Device/DAQ settings window then clicking on OK to send the non-
advanced settings to the unit. 

 

Acquisition tab 

 
This section of the manual is about the Magnetic Acc mode when the Advanced 
Mode is selected in the Optons/Preferences menu of Source Signature.  The 
Advanced Mode also makes added options available in modes other than 
Magnetic Acc. 

 

Trigger tab 

 
The Trigger tab is only present in the Advanced Mode.  Additional trigger options 
are available in Advanced mode of VibQC and other modes.  Things such as pre 
and post trigger, trigger channel selection, triggering on a specified GPS time, 
etc. are available in Advanced mode. 

 

Advanced Tab 



 
The Advanced tab is only present in the Advanced Mode.  Functions available in 
this tab are not needed in most situations. 

 

Channels Configuration 

 
The configuration of all the channels may be defined in this widow.  The types 
Ref, LBP, LRM, SBP, and SRM should not assigned to more than one channel 
for each type, e.g. assign only one channel with Ref type, one as LBP, etc. 

 

Channel Input 

 
The channel input for each channel may be defined by clicking on the pull-down 
button for that channel.  The only inputs useful for field use are Normal and 
Current.  The other inputs are for testing by Seismic Source personnel.  
Selecting the Current mode turns on the power supply and current regulator for 
the channel.  Current regulators may be selected for any channel(s) but  there 
are no current regulators (hardware) for channels 9, 10, and 11.   

 

Same settings in all channels check 

 
The configurations of all the channels may be copied from the channel currently 
being configured if this feature is enabled.  This is typically not desirable. 

 

Sample Interval 
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Acquisition Time 

 
 

 

Low Cut Filter 

 
 

 

OK button 

 
 

 

Cancel button 

 
 



  Auto Download Menu 

 
 

 
 

Disable Auto Download 

 
Only use this option when it is not desired to download data from a connected 
unit. 

 

Auto Download VSS DAT data 

 
Select this option for automatic data downloading from a Bird Dog 3-11 Vib QC 
unit and 3 channel data from a Force III.  

 

Menu item 

 
Select this option for automatic data downloading 11 channel data from a Force 
III.  The Force III must have the Vib Record set to ON in the SERVICE/TESTS 
menu on the front panel of the Force III for this freature to work. 
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  Preferences window 

 
 

General 

 
Opens the General window, which is displayed here. 

 

Auto Save 

 
Opens the Auto Save window. 

 

Filters 



 
Opens the Filters window. 

 

Lock 

 
Opens the window to allow locking selections. 

 

Units 

 
Select as desired. 

 

Advanced Mode 

 
Should not be selected for most work. 

 

OK 

 
 

 

Cancel 
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  Auto Save 

 
 

Auto Save tab 

 
 

 

Auto Save Records to File 

 
If enabled, another option will be available, Confirm Before Saving To File. 

 

Save Path 

 
 

 

File Type 

 
Can select SEG-Y, SEG-2, or ASII CSV 

 

Short File Names (00001.ext) option 

 



 
 

Detailed File Names (Unit_Date_Time.ext) option 

 
 

 

File Number Length 

 
Sets the number of digits to be used in the file number. 
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  Filters 

Enable Or Disable Filters With Buttons On The Tool Bar Or  
In The View Pull-Down Menu. 

 

 
 

Filters tab 

 
Settings in this tab control filtering of plots but not of saved data. 

 

High Cut Frequency 

 
 

 

Low Cut Frequency 

 
 

 

Notch Center Frequency 

 
 

 



 

Export filtered data if filter enabled check 

 
 

 

Remove DC offset when exporting check 

 

Disabling Low Cut Filters 

 
 

Acquisition tab 

 
In the Options/Device/DAQ Setup/Configuration window. 

 

Low Cut Filter Selection 

 
Some plots or test results may be bad if the low cut hardware filters are enabled.  
When using a Bird Dog 3-11 unit, the low cut hardware filters should be disabled.  
To do this, go to the Optoins/Preferences menu and select Advanced Mode then 
go to the Options/Device/DAQ Setup/Configuration window and select Low Cut 
Filter - Disabled then left click on the OK then Close buttons.  After doing that it is 
almost always best to go to the Optoins/Preferences menu and deselect the 
Advanced Mode. 
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  Lock 

 
 

Lock tab 

 
 

 

Lock Menu And Toolbar check 

 
 

 



  Window Menu 

 
 

These are standard operating system windows control functions with the exception of 
Close Plot. 
 

Tile Horizontally 

 
A standard operating system function.  The active plot will be moved to the top or 
top left plot when Tile Horizontally is selected.  This allows one to re-order the 
plots on a multi-plot screen. 

 

Tile Vertically 

 
A standard operating system function.  The active plot will be moved to the left or 
top left plot when Tile Vertically is selected.  This allows one to re-order the plots 
on a multi-plot screen. 

 

Cascade 

 
A standard operating system function. 

 

Close Plot 

 
Closes the plot that is currently selected plot window 
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Plot Selection Window 

 
A list of the active plots is displayed here.  Clicking on a plot will make it the 
currently selected plot.  Another way of making a plot the currently selected plot 
is to click somewhere in that window, including the title bar for that plot.  Clicking 
on a plot that is listed here that has been will cause that plot to be displayed. 

 



   
 
 
 
 
 
 

Help Menu 

 
 

 
 

About 

 
A standard operating system function. 
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  Tool Bar 

 

Notes:  Refer to the pull-down menu sections for more features and 
descriptions. 
            Tools with a toggle function will be highlighted when selected. 

 
 

File Control Area 

 
Click here to clear current data, open or save a file, or send a screen shot to a 
printer. 

 

Plot Zoom Controls 

 
Control the axes of the graphs or zoom out so that all the plot is visible. 

 

Plot Processing Controls 

 
Features here include inverting signal plots (except reference), remove DC, 
smooth most plots (not correlation envelope), low and high cut filters and notch 
filter.  These functions do not affect saved data exept for exported files when the 
save filtered features are selected in the Preferences/Filters menu.     

 

Plot Type Selection 

 
Click here to open a new plot, or change the currently selected plot to a new plot 
type, such as signal, spectrum, correlation. analysis, distortion, and comparison. 

 

Overlay Control 

 



Automatic plot overlay of all plots or clearing overlays are available here. 
 

Acquisition Control 

 
Click on the left or center button to enable or disable data acquisition when 
connected to a Bird Dog 3-11 VibQC unit.  Click on the right button or open the 
Device menu to allow selection and setup of devices connected to the computer. 
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  Plot Functions 

 
 

Title Bar 

 
Shows plot type and operating system buttons to control the plot window. 

 

Plot Area 

 



This is the area that may be occupied by the plot. 
 

Plot Control 

 
Right clicking inside the graph opens this window.  Store plot only stores one of 
the traces in a multi-trace plot.  Up to 8 traces may be stored.  The Plot Type 
may also be changed from this menu. 

 

Trace Scaling Window 

 
This windows is shown when Scale is selected in the Plot Control window.  The 
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button in the top left corner closes this window.  Examples of the effects of 
scaling functions follows this section. 

 

Trace Scaling Type 

 
 

 

Trace Selection 

 
Individual traces of a multi-trace graph may be suppressed or enabled. 

 

Manual Scaling Control 

 
Scaling of all traces may be increased, decreased or reset.  Channels may also 
be subjected to clipping. 

 

Legend 



 
Shows the trace names for multi-trace graphs. 
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  Examples Of Scaling Control Selections 
These are all the same data signal plots with different scaling options selected. 

 
 



  Accelerometer Test Option Procedure 

Connect the accelerometer unit to be tested to the Bird Dog 3-11 unit. 
 
Connect the Bird Dog unit to D.C. power. 
 
Connect the Bird Dog unit to the computer. 
 
Start the AccTest application. 
 
Follow the instructions in the Acc Test section of this manual. 
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  Acc Test 

 
 

Sensitivity 

 
This setting should not normally need to be changed.  It sould be set to 25 for M5 
or M6 accelerometers. 

 

Acquisition Time 

 
Set the acquisition time to desired acquistion length.  Two seconds is typically 
sufficient. 

 

Noise Limit 

 
Set the desired noise level limit.  It is important that the surface the 
accelerometer is resting on is vibrating as little as possible.  100 uV is the 
recommended setting. 

 

Trend Limit 

 
Set the desired trend limit.  If accelerometers are put in place and not moved for 
about 10 seconds before starting a test, the trend will usually be well below 100 
uV. 



 

Loop Channel Select 

 
The Loop Channel will not normally need to be set.  When using the cable 
provided by Seismic Source Co., the Loop Channel Number will be 2. 

 

Sim Channel Select 

 
The Sim Channel will not normally need to be set.  When using the cable 
provided by Seismic Source Co., the Sim Channel Number will be 3. 

 

Bird Dog 3-11 Status 

 
The status of the Bird Dog unit (DAQ Link) will be shown here.  The status will be 
Offline until the program detects the unit.  Left click on the Detect button after the 
unit is connected to the computer and powered up.  The status will change to 
Online when the program establishes communication with the unit. 

 

Bird Dog 3-11 Info 

 
The information fields of this window will be populated after the program 
establishes communications with the unit.  The DAQ number field shows the 
serial number of the unit. The Version field shows the firmware version 
programmed into the unit.  The Network Settings field shows the IP address of 
the unit. 

 

Test 1 Prompt 

 
After the program detects the unit, this prompt will become active.  The presence 
of a green arrow pointing toward the prompt indicates this.  Connect the cable to 
the accelerometer to be tested and set the accelerometer on a surface that is as 
level and quiet (non-vibrating) as possible for the test.  Wait about 10 seconds 
with the accelerometer sitting still before starting this test by left clicking on the 
Start button.  The power supply for the accelerometer may not be turned on until 
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this test is started the first time after the program identifies the unit.  See the 
Accelerometer Powering-Up section for a plot showing this. 

 

Start / Cancel Test Buttons 

 
Left click on the Start button to start the active test.  A test in progress may be 
canceled by left clicking on the Cancel Test button. 

 

Test 1 Measurements 

 
After Test 1 is finished the data in the measurements fields should be populated. 

 

Test 1 Quality 

 
After Test 1 is finished, if the measurements are within the selected limits, the 
Quality should indicate Good.  If any measurement is not with the limits, the 
Quality should indiciate Bad 

 

Graphs 

 
Oscillographs of the acquired data will be shown in the Graphs windows.  This 
example shows data has been acquired for Test 1 but has not been acquired for 
Test 2. 



 

Test 2 Prompt 

 
This shows Test 2 is the active test and the progress bar shows data is being 
acquired.  A similar progress bar will indicate data acquisition when Test 1 is 
being run.  For Test 2, use some sort of spacer(s) to make sure the 
accelerometer is upside down and supported on a surface that as level and quiet 
as possible.  Let the accelerometer sit still on the support(s) about 10 seconds 
before starting this test.  After this test is finished, the lower graph area will be 
completed.  Measurements and Quality fields for Test 2 will be populated. 

 

Loop Error 

 
After Test 1 and Test 2 are completed the sensitivity error of the loop 
accelerometer in the accelerometer unit being tested will be shown here. 

 

Sim Error 

 
After Test 1 and Test 2 are completed the sensitivity error of the sim 
accelerometer in the accelerometer unit being tested will be shown here. 

 

New Test, Clear Data Button 

 
This button will not initialize the program for starting a new test sequence.  Data 
for Test 1 must be acquired before running Test 2.  If a test sequence should be 
started over, complete any testing until the Test 1 Prompt is active, then start a 
test sequence. 

 

Loop Reisitence 

 
These values are only used when a new accelerometer is being built  They have 
no practical use other than in the production laboratory. 
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Sim Resistance 

 
These values are only used when a new accelerometer is being built  They have 
no practical use other than in the production laboratory. 

 



  Accelerometer Powering-Up 

 
 

Accelerometer Powering-Up 

 
The graphs will indicate the voltage rising after starting the test for the first time.  
This will normally only happen if the power supply for the accelerometer is off, 
indicated by the CURR REG LED being off, before the test is started.  This plot 
indicates an unusable data acquisition.  The power supply will be normally stay 
on after the test is run one time.  Repeating the tests so that the CURR REG 
light is on before Test 1 is started will normally avoid this situation. 
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  External Cables 
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  Additional Ethernet Setup Information 
Windows VISTA Operation 
When using Windows Vista Operating System the VScope program cannot be installed in the 

Program Files subdirectory. 

A new subdirectory on the C drive should be made and the VScope.exe should be copied to this 

subdirectory.   

IP address setup must be set to a fixed IP address and all firewalls must be disabled. 

 

Disable the Windows Firewall by selecting the Firewall selection in the “Network and 

Internet” selection in the Control Panel 

 
With Windows Vista computer, the Ethernet setup is done by the following procedure: 

Go to the Control Panel and select “View network status and tasks”. 

 
 

 

 

Select “Manage network connections” 

  



 
 

Right Click on the “Local Area Connections” and select “Properties” 

 
 

 

It is also recommended to disable all other Network connections.  Highlight the other Network 

Connections (like Wireless) select “Connectivity” and Disable. 

Highlight the “Internet Protocol Version 4 (TCP/IP)” and Click on Properties button. 
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Use following IP address: 

IP address10.0.0.101 

Subnet Mask255.0.0.0 

Press OK to accept entries. 

 

 

 
 

 

 

 

 

 

Windows XP Ethernet setup 

 
With Windows XP computer setup in classic mode, the Ethernet setup is done by the following 

procedure: 

 

Go to the Control Panel and open the Network Connections. 



 
 

 

 

Right Click on the Local Area Connection Icon and select properties. 

 

 
 

 

 

Scroll Down to the Internet Protocol TCP/IP selection and click on this icon. 

 

Click on Properties button. 

Use following IP address: 
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IP address10.0.0.101 

Subnet Mask255.0.0.0 

Press OK to accept entries. 

 

 
 

 

It is sometimes necessary to reboot the computer to have the new address take affect.   

 

If the Bird Dog 3-3I unit was previously communicating with a computer with a different address, 

then the Bird Dog 3-3I unit must be reset (power off then on) for the unit to communicate to the 

new address. 

 

With Windows XP there is an additional Authentication Tab.  The Authentication must be 

disabled to operate with the Bird Dog 3-3 unit. 

 

 

Windows 7 and Windows 8 
With Windows 7 and Windows 8 there is normally a quick access to the IP settings 

 

In the lower left hand corner, there are multiple icons.   

 



 
 

Right Click on the WiFi Icon   

 
Then Select “Open Network and Sharing Center” 

 
 

Then select “Change adapter Settings” 

 

 
 

 

 

 

Double Click the Wired Ethernet used by the Bird Dog 3-3 unit 

 

On the Ethernet status screen – click the “Properties” button at the bottom. 

 

On the Ethernet Properties screen select the “Internet Protocol Version 4 (TCP/IPv4) 
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Then set the IP address to a fixed IP 

 

We suggest using 10.0.0.101 for the computer, with the 255.0.0.0 Subnet mask 

 
 



 

The Network selections can also be access via the windows 8 start menu. 

 
 

Search for the “network” software 
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Click on the Network application 

 

 
 

Double Click the Wired Ethernet used by the Bird Dog 3-3 unit 

 

On the Ethernet status screen – click the “Properties” button at the bottom. 

 

On the Ethernet Properties screen select the “Internet Protocol Version 4 (TCP/IPv4) 

 



 
 

Then set the IP address to a fixed IP 

 

We suggest using 10.0.0.101 for the computer, with the 255.0.0.0 Subnet mask 
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Firewall 
It is important to disable all Firewalls on the computer.  Third party firewall from Norton, 

McAfee or other companies can completely disable the operation of the BD3 Recording system 

unit.  Typically the Firewall will allow the “ping” command to operate, but will block all other 

commands and messages. 

 

There is a built in Firewall with Windows XP.  This should be disabled.  Go to the Advanced 

Menu of the Local Area Properties and disable the Firewall. 

 

 



 
Typical Firewalls will ask if the program should be “blocked”, 

 always select “Unblock this program” if asked. 

 

 

TCP/IP Verification 
To verify that the IP address is correct, select “Start”, then “Run”, then type in “CMD”.  This 

starts the command prompt in Windows (This is similar to the old DOS command prompt).  Type 

the command “ipconfig”.  The current ip address 192.168.0.101 should be shown. 

 

 
 

 

Viewing the Network Tab at the bottom of the VScope program can also check the IP address. 

 

 
The Network Tab shows the current IP address detected by the VScope program. 
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Also if the Bird Dog 3-3 unit was previously communicating with a computer with a different 

address, then the Bird Dog 3-3 unit must be reset (power off then on) for the unit to communicate 

to the new address. 

 

With some of the Windows versions there is an additional Authentication Tab.  The 

Authentication must be disabled to operate with the Bird Dog 3-3 unit. 

 

 

 

 

 



  

 


